OilPaint
Oil Painting Effect
akvis.com
CONTENTS

- Field of Application
- Installation on Windows
- Installation on Mac
- Activation
- License Comparison
- How It Works
  - Workspace
  - Using the Program
  - Tools & Brushes
  - Oil Painting Effect
  - Abstract Art
  - Canvas
  - Frames
  - Text & Watermark
  - Presets
  - Preferences
  - Batch Processing
  - Print Image
- Examples
  - Autumn Romance
  - Girl on the Sea
- AKVIS Programs
AKVIS OilPaint is photo to painting software that creates oil paintings from photographs. The characteristic feature of the program is a unique algorithm of the artistic application of brush strokes that authentically reproduces the technique of the real brush.

Creating a real oil painting is long and complicated process. With the OilPaint software you can become a painter and turn your photos into works of art in just a few minutes!

Oil painting is one of the most popular techniques. The history of this method goes back many centuries. Traditionally, artists apply oil paints to a linen or cotton canvas. The advantages of oil painting are bright luminous colors which blend well, expressiveness of the brush strokes that gives the picture a special rough texture, brilliance and naturalness of the picturesque image.
Oil painting technique is widely used for creating artworks in different artistic styles - Impressionism, Abstract art, Photorealism, and others; in the genres of still life, landscape, portraiture, history painting, or scenes from everyday life.

Even if you are not a professional painter you can create your own masterpiece! Just use AKVIS OilPaint to turn a regular photo into an oil painting. Adjusting the density, texture, and thickness of the brush strokes, you can not only get impressive effects, but also find your own painting style.
The mysterious production of an artwork happens right before your eyes. The program creates a picture that looks like a handmade oil painting. Personalize your work by adding text or watermark. To enhance the authenticity of your painting adjust the canvas surface. Put a ready image in one of the frames from the rich collection incorporated in the software.

Using the Abstract Art tab, you can give a modern spin to traditional oil paintings. It lets you turn any image into a unique abstract painting full of vibrant colors and fantastical shapes.
The software offers a number of ready to use Presets that let you familiarize yourself with the features. The Batch Processing support allows you automatically create a series of images in the oil painting style.

Using the additional post-processing tools you can add final touches to your painting, and strengthen or reduce the oil effect on certain areas.
AKVIS OilPaint is available as a standalone program and as a plugin to photo editors: AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, etc. Consult the compatibility page for more details.

The functionality of the program depends on the license type. During the trial period you can try all options and choose the license you like.
Follow the instructions to install **AKVIS OilPaint** in Windows.

- Start the setup **exe** file.
- Select your language and press the **OK** button to launch the installation process.
- To continue the installation process you have to read and accept the **License Agreement**. Activate the check box "**I accept the terms in the license agreement**", and press **Next**.

![License Agreement Screen](image.jpg)

- To install the **Plugin** you should select your photo editor(s) from the list. **Hint:**
  If your photo editor is not in the list, activate the component **Custom Plugins Directory** and choose the folder where you keep all plugins and filters, for example, **C:\My Plugins**. In this case you should set this folder as the plugins folder in the settings of your photo editor.
  Or you can copy the **8bf** file into the Plug-ins folder of your image editor.

To install the **Standalone version**, make sure that the check-box **Standalone** is activated. To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**. Press the button **Next**.
• Press the button **Install**.

• The installation is in progress.
• The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

• Press Finish to exit Setup.

After installation of the standalone version of OilPaint, you will see a new line in the Start menu: AKVIS - OilPaint and a shortcut on desktop, if during installation the component Shortcut on Desktop was enabled.
After installation of the OilPaint plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: **Filter -> AKVIS -> OilPaint.** Please use this command to launch the plugin in the editor.
INSTALLATION

Follow the instructions to install AKVIS OilPaint in a Mac computer:

- Open the virtual disk dmg:
  - akvis-oilpaint-app.dmg to install the Standalone version
  - akvis-oilpaint-plugin.dmg to install the Plugin to your image editor (Photoshop or Photoshop Elements).

- Read the License Agreement and press Agree, if you agree with the conditions.

- Finder will open with AKVIS OilPaint application or AKVIS OilPaint PlugIn inside.

- To install the Standalone version just drag the AKVIS OilPaint application into the folder Applications (or any other place you like).

To install the Plugin drag the entire AKVIS OilPaint PlugIn folder into the Plug-Ins folder of your graphic editor.

For example:

if you use Photoshop CC 2019, copy the plugin into Applications/Adobe Photoshop CC 2019/Plug-Ins;

if you use Photoshop CC 2018, copy the plugin into Applications/Adobe Photoshop CC 2018/Plug-Ins;

if you use Photoshop CC 2017, copy it into Applications/Adobe Photoshop CC 2017/Plug-Ins;

if you use Photoshop CC 2015.5, copy it into Library/Application Support/Adobe/Plug-Ins/CC;

if you use Photoshop CC 2015, copy it into Applications/Adobe Photoshop CC 2015/Plug-ins;
if you use **Photoshop CS6**, copy it into **Applications/Adobe Photoshop CS6/Plug-ins**.

After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: **Filter -> AKVIS -> OilPaint**.

Run the standalone app by double-clicking on its icon in Finder.
HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.
If it is not possible, we offer you an alternative way (see below for Offline Activation).

Download AKVIS OilPaint and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.

You can also open the About the Program window by pressing the button in the program’s Control Panel.

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.
Click on **ACTIVATE** to start the activation process.

Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press **ACTIVATE**.

Your registration is completed!

**Request by e-mail:**

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation:**

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (**OilPaint.lic**) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users’ Shared (Public) Documents:

- **Windows Vista/7/8/10:**
Users\Public\Documents\AKVIS;

- **Windows XP**:
  
  Documents and Settings\All Users\Documents\AKVIS;

- **Mac**:
  
  Users/Shared/AKVIS.

Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
AKVIS OilPaint imitates oil painting technique.

The functionality of the program depends on the license type. During the test period you can try all options and choose the license you like.

Every time you start the unregistered version you can choose between functionality types to test: **Home** (either the plugin or the standalone edition), **Home Deluxe** (plugin+standalone) or **Business** (plugin+standalone).

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th>Home (Plugin)</th>
<th>Home (Standalone)</th>
<th>Home Deluxe (Plugin+Standalone)</th>
<th>Business (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>non-commercial use</em></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><em>commercial use</em></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standalone</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oil Painting Effect</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Artistic Edge Effect</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Abstract Art</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Tools:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Stroke Direction Tool</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Post-Processing Tools</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Additional Features:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text &amp; Watermark</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Canvas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frames</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Presets</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import/Export Files:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.oilpaint (Presets)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>* (Guiding lines)</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Batch Processing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Large Format Print</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Color Space</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CMYK</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Lab</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Grayscale</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>8 / 16 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>32 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Image Format</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>JPEG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>BMP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RAW</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PSD</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>OS</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7, 8, 8.1, 10 - 32-bit, 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mac OS X 10.11, macOS 10.12-10.14 - 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>10-days trial</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Price</td>
<td>$49</td>
<td>$49</td>
<td>$69</td>
<td>$89</td>
</tr>
</tbody>
</table>
AKVIS OilPaint can work independently as a standalone program as well as a plugin to a photo editor.

- **Standalone** is an independent program; you can open it by clicking on the program's icon.
  
  To launch the standalone version, run the program directly:
  
  On a Windows computer - select it from the **Start** menu or use the program's shortcut.
  
  On a Mac computer - launch the app from the **Application** folder.
  
- **Plugin** is an add-on for a photo editor, for example for Photoshop.
  
  To call the plugin, **select it from filters** of your image editing program.

The program's workspace looks like this:

![Workspace of AKVIS OilPaint](image)

The left part of the AKVIS OilPaint window is taken by the **Image Window** with two tabs: **Before** and **After**. Under the **Before** tab you can see the original photo. The **After** tab shows the resulting image. You can switch between the windows by left-clicking on the tab with mouse button. To compare the original and the resulting images, click on the image and hold the button pressed - the program will currently switch between tabs.

In the upper part of the program's window you can see the **Control Panel**.

- The button ![home page](image) opens the home page of AKVIS OilPaint.
  
- The button ![loading operations](image) is used for managing the loading operations.
Right mouse click on this button displays the list of recent images. You can change their number in the program's preferences.

Left mouse click shows the list of the commands:

- (available only in the standalone version) - It opens an image.
  The hot-keys are Ctrl+O on Windows, ⌘+O on Mac.
- It loads a list of presets (.oilpaint file).
- It loads saved guiding lines (.direction file).

The button shows the list of the saving commands:

- (available only in the standalone version) - It saves the image in the chosen format.
  The hot-keys are Ctrl+S on Windows, ⌘+S on Mac.
- It saves user presets to a file with the .oilpaint extension.
- It saves the guiding lines to a .direction file.

The button (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P on Windows, ⌘+P on Mac.

The button lets posting pictures from the program to the social networks: Twitter, Flickr, Tumblr, Google+.

The button shows/hides the guiding lines.

The button cancels the last operation (with the tools). It is possible to cancel several operations in a row. The hotkeys are Ctrl+Z on Windows, ⌘+Z on Mac.

The button returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are Ctrl+Y on Windows, ⌘+Y on Mac.

The button (only in the standalone version) opens the Batch Processing dialog to automatically process a series of images.

The button initiates image processing with the current settings. The resulting image is shown in the After tab.

The button (only in the plugin version) applies the result to the image and closes the plugin.

The button shows information about the program: version, trial period, license.

The button calls the Help files. The hot-key is F1.

The button calls the Preferences dialog box for changing the program's options.

The button opens a window showing the latest news about OilPaint.

To the left of the Image Window there is the Toolbar. Different tools appear on the Before/After tabs.

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.
To scroll the image in the **Image Window** you can press the spacebar on the keyboard and drag the image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the `Ctrl` key pressed – to the left/to the right, by keeping the `Alt` key pressed – scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons [+][−], to scale the image in the **Image Window**. When you click on the [+][−] button or move the slider to the right, the image scale increases. When you click on the [+][−] button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale: `+` and `Ctrl++` (`⌘++` in Mac) to increase the image scale and `−` and `Ctrl+-` (`⌘+-` in Mac) to reduce the scale.

Under the **Navigator** there is the **Settings Panel** with the **Painting**, **Abstract Art**, and **Decoration** tabs:

- **Painting**: Here you can adjust the parameters for photo to painting conversion.
- **Abstract Art**: Create colorful artworks with whimsical and fantastic shapes.
- **Decoration**: You can add text to your image, adjust the canvas, and apply a frame.

Below, in the **Presets** field you can save the current settings as a preset to use them in the future. The current settings can be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

Under the **Settings Panel** you can see **Hints** for the parameters and buttons when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program’s **Preferences**.
AKVIS OilPaint is photo to painting software that creates oil paintings from photographs. It can work independently as a standalone program and as a plugin to a photo editor.

Follow the instructions below:

**Step 1.** Open an image.

- If you work with the standalone edition:
  
The dialog box **Select File to Open** appears if you double-click on the empty workspace of the program or if you click on then on . Use the hot-keys: Ctrl+O on Windows, ⌘+O on Mac. You can also drag the required image into the workspace of the program. The standalone program supports JPEG, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:
  
  Open an image in your photo editor by calling the command **File -> Open**.

  Call the plugin from the menu of the editor:

  In **AliveColors**: Effects -> AKVIS -> OilPaint;
  in **Adobe Photoshop**: Filter -> AKVIS -> OilPaint;
  in **Corel PaintShop Photo Pro**: Effects -> Plugins -> AKVIS -> OilPaint;
  in **Corel Photo-Paint**: Effects -> AKVIS -> OilPaint.
**Step 2.** Before applying the effect, in the standalone version, you can use the **Crop tool** to trim a part of the picture. If you use the plugin, you can do this in your image editor.

![Crop Tool](image)

**Step 3.** Adjust the **oil painting settings** in the **Painting** tab.

Using the **Abstract Art** tab you can change the shape and color of objects, giving them a unique and fantastic look.

You can use one of the ready-to-use **presets** or set the parameters to your liking.

The result of image processing will be immediately shown in the **Preview Window** which is visible in the **Before** tab if the button in the Toolbar is pressed.

![Preview Window](image)

**Step 4.** Press the button to convert the entire image into a painting with the selected settings. To interrupt the process, click on the **Stop** button right to the progress bar.
If you have not adjusted the values, the program will process the image with the last used settings.

Step 5. For the advanced licenses (Home Deluxe/Business), it is possible to improve the result using the Stroke Direction tool. It changes the direction of the brush strokes created during the automatic conversion.
Step 6. To make your oil painting even more impressive, you can use the Decoration options: adjust the canvas, apply a frame, and add text to your image.

Hint: The order of the application of Canvas/Frame/Text depends on the position of the tabs. Drag the tabs to change the order.

Step 7. If you like the settings, you can save them as a preset and use them later. All the tabs in the Settings Panel have the common list of presets. When a new preset is created, it will be available in all tabs and will contain their settings.

Step 8. You can also make final touches and correct the result using the Post-Processing Tools on the After tab. These brushes are only available under the Home Deluxe/Business licenses.

Attention! Use these tools at the final step. If you run the processing again, the changes made with the tools will be lost!

Step 9. You can share your work of art by clicking on . It lets you publish the image from the program to the social networks: Twitter, Flickr, Tumblr, Google+.

In the standalone version you can also print your oil painting with .

Step 10. Save the processed image.

- If you work with the standalone edition:

  Click on then on to open the Save As dialog box. You can use the hot-keys: Ctrl+S on Windows, ⌘+S on Mac. Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.
- If you work with the plugin:

Press the button ☑ to apply the result and close the plugin window. The **AKVIS OilPaint** plugin will close and the picture will appear in the workspace of the photo editor.

Call the **Save As** dialog box using the command **File -> Save As**, enter a name for the file, choose the format and indicate the target folder.
TOOLS AND THEIR OPTIONS

The left panel in AKVIS OilPaint (Toolbar) contains three groups of tools: pre-processing, post-processing, and additional tools. Different tools are visible depending on the active tab - Before or After.

Hint:

You can use the buttons and to undo/redo the operations made with the tools:

Pre-Processing Tools (on the Before tab):

Quick Preview switches on/off the preview window. It is a square frame outlined with the "marching ants" that displays changes made in the Painting and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture, click and keep mouse pressed within the preview area.

You can adjust the preview window size in the program's preferences.

Crop (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.
Note: This tool is applied to the original image! Use it before the oil effect.

You can change the crop area by dragging the sides and the angles of the bounding frame.

Use the buttons in the Settings Panel to control the tool:

To apply the result and remove the areas outside the frame, press OK or use Enter. To cancel the operation and exit the tool, press Cancel or use the Esc-key. To restore the original area keeping the tool active, press Reset button.

Adjust the crop options:

You can choose the size of the crop rectangle from the Ratio drop-down list or enter your custom aspect ratio.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

Stroke Direction gives you full control over the strokes. With this technique you can achieve truly realistic paintings with human hair, patterns, and textures going in the right direction.

Note: This feature is only available for the advanced licenses (Home Deluxe, Business).

Add the guiding lines with this tool, and the program will re-make the painting following the new direction. The changes will be shown in the preview window. To process the entire image, click on the button.
**Hint:** You can save 🎨 and load 🪤 the guiding lines created with this tool.

Loaded lines automatically adapt to the image size.

**Eraser 🗑** lets you edit and remove the guiding lines drawn with the **Stroke Direction** tool 🖼. The size of the eraser can be adjusted by right clicking on the image.

### Post-Processing Tools (on the **After** tab, for Deluxe/Business):

**Attention!** The tools 🗑, 🪤, 🖼, 🖼 are only available under the **Home Deluxe/Business** licenses, on the **After** tab. **Use them at the final step.** If you re-run the image processing 🖼, the changes made with the post-processing tools will be lost!

Watch the video tutorial that demonstrates how to use the post-processing tools.

The options of these tools are shown in a pop-up box which appears after right-clicking in the image.

**Smudge 🖼** is used to manually refine the image by removing paint irregularities. It mixes colors by displacing pixels, like a finger passing through wet paint. The tool lets you quickly add a handmade touch to your oil painting.

The tool's parameters:

- **Size (1-300).** The maximum width of a line drawn with the tool.
- **Hardness (0-100).** The amount of blurriness of the outer edge. The higher the value, the harder the brush edge is.
- **Strength (1-100).** The intensity of smearing the paint in the brush stroke. The higher the value, the more color is smeared.
History Brush lets you fade the effect and restore the image to its original state. You can choose the mode of the tool: edit all changes or only brushes keeping the oil effect.

The tool's parameters:

- **Restore to Original.** If the check-box is enabled, the tool lets weakening the oil painting effect, as well as the result of the post-processing brushes. If the check-box is disabled, the tool edits only these brushes but does not affect the oil effect.

- **Size** (1-500). The maximum width of a line made by the brush.

- **Hardness** (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool’s edges become. At value 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

- **Strength** (1-100). The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at value 100% the original image will be restored more completely.

- **Aspect** (1-100). At value = 1 the brush is flattened into a line, at 100 it is a circle, and at intermediary values it is an ellipse.

- **Angle** (0-180). The rotation angle of the brush.
Oil Brush is designed to strengthen the oil effect on desired areas. This tool lets you make high quality strokes that look like made with a real oil paint brush.

**Size** (2-150). The maximum line width which can be drawn with the brush.

**Relief** (0-100). The prominence of stroke details. As this parameter is increased, the pattern left by the brush’s hairs in the paint is more pronounced and the relief of strokes is stronger.

**Paint Reserve** (0-100). The length of the brush stroke. When the paint runs out, the brush stops painting on the surface and leaves a raised, faded stroke of paint.
**Color Mixing.** This option defines the state of the paint in a stroke. When the check-box is enabled, the brush strokes will mix together as if the paint is wet. If the check-box is disabled, the paint will behave as if it is drying, and the strokes will not mix.

**Cleaning.** This option works only if **Color Mixing** is active. If the check-box is enabled, the brush will clean for each new stroke, a new line will start with the defined color. When it is disabled, a new stroke will be drawn with the color that brush had at the end of the previous stroke.

**Flat Brush.** The check-box changes the shape of the edges of the brush strokes. If it is enabled, the strokes look like drawn with a flat brush or a palette knife. When this option is
disabled, the brush strokes look like created with a round brush or as if paint squeezed out of a tube.

![Flat Brush is enabled](image1.png) ![Flat Brush is disabled](image2.png)

**Color.** The color square on the Toolbar under the **Oil Brush** displays the selected color for this tool. There are two ways to change colors for the brush:

- Double-click on the square and choose a color from the **Select Color** dialog.
- Left-click on the square (or use the `I`-key) to activate the **Eyedropper** tool, then pick a color from the image.

![Eyedropper](image3.png)

Around the eyedropper’s tip over the image there is a color ring that helps you select colors more precisely. If it’s hard to catch a certain color, you can see adjacent tints and select the color on the ring while holding the `Ctrl`-key.

There are 5 sectors on the color ring:

1. Gradient line with the current color in the center. On the left side is +30% black, and on the right side +30% white.
2. The previously selected color.
3. The current color of the pixel where the cursor is.
5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px.

**3D Brush** lets you bring volume and relief to your painting. The tool draws prominent strokes without changing colors.

**Size** (2-300). The maximum width of a line drawn with the tool.

**Smearing** (0-100). The parameter defines the state of the paint when drawing with the brush. At value = 0 the strokes do not mix together. The higher the value, the more strokes will be smeared and mix.
Smearing = 0  Smearing = 90

Relief (0-100). The prominence of the traces of the brush strokes. The higher the value, the more expressive the strokes are. At low values it gives the smoothing effect.

Relief = 10  Relief = 50

Flat Brush. It works similarly to the same option of the Oil Brush.

Additional Tools (available on both tabs, for all licenses):

Hand lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The hot-key is Z. Double-clicking on the tool's icon on the Toolbar makes the image fit the window.

Zoom lets you change the image's scale. To zoom in left click on the image. To zoom out left click with Alt on the image. The hot-key is Z. Double-clicking on the tool's icon makes the image scale to 100% (actual size).
OIL PAINTING EFFECT

AKVIS OilPaint creates oil paintings from photos. The unique algorithm authentically reproduces the technique of the real brush. The mysterious transformation happens right before your eyes creating a work of art that looks like a handmade painting.

In the Painting tab in the Settings Panel, you can set the parameters of the photo-to-painting conversion.

![Oil Painting From Photo](image)

In the Image tab, adjust the main parameters of the oil painting effect.

**Simplicity** (1-10). The parameter adjusts the simplification of the image. The higher the value of the parameter, the rougher the brush strokes are, and the more details disappear. Higher values make the result look like a painting, lower values keep it closer to the original photo.

![Simplicity = 2](image) ![Simplicity = 8](image)

**Saturation** (0-70). The parameter lets toning the image with brighter colors. At the value = 0 the original colors are used.
Max Stroke Length (1-100). The parameter defines the maximum stroke length.

Stroke Thickness (1-20). The parameter adjusts the width of the brush strokes.

Stroke Intensity (0-50). The parameter adds volume and relief to the brush strokes making them more distinct and perceptible, accentuated and expressive.
**Stroke Curvature** (0-50). The parameter changes the stroke form - straight or curved. The complexity and curvature of the strokes depend on the parameter value. The shorter the strokes are, the more they can bend.

**Wide Background Strokes** (1-10). The parameter lets you increase the width of the brush strokes in uniform areas, that helps to get more realistic results on backgrounds and close-up portraits.

**Random Strokes** (1-50). The parameter randomizes the arrangement of the brush strokes.
In the **Edge** tab, set the parameters of the additional edge processing.

**Note:** This effect is only available for Home Deluxe and Business licenses.

**Add Strokes.** Enable the check-box to draw additional strokes on the edges of the image.

**Number of Strokes** (1-100). The parameter determines the number of brush strokes.
**Number of Strokes** (10-60).
The parameter adjusts the width of the brush strokes.

**Stroke Thickness** (0-100). The parameter defines the maximum stroke length.

**Max Stroke Length** (10-100). The parameter adjusts the transparency of the stroke edges.

**Hair Thickness** (15-50). The parameter determines the width of brush's hairs in each stroke. At lower
values, the brush's hairs are sharp and thin. At high values, they are wide and smooth.

![Hair Thickness comparison](image1)

**Stroke Color.** Enable the check-box to draw strokes of a specified color. When the check-box is disabled, the color is set using the background color property.

![Stroke Color examples](image2)

**Relief (0-100).** The parameter makes the strokes look more prominent.

![Relief examples](image3)

**Ellipse.** Enable the check-box to arrange the strokes in the form of an oval.
Click the **Random** button to set the settings randomly.

With the advanced licenses (**Home Deluxe**, **Business**) you can also use these tools:

**In the **Before** tab:**

The **Stroke Direction** tool gives you full control over the brush strokes. With this technique, you can achieve truly realistic paintings with human hair, patterns, and textures going in the right direction. Using this tool you can add your own creative touch to your oil painting.

**In the **After** tab:**

You can use the post-processing tools to manually edit the result.

Use these tools at the final step! If you re-run the processing, the changes made with these brushes will be lost!
ABSTRACT ART

Using the **Abstract Art** tab you can change the shape and color of objects, giving them a unique and fantastic look.

**Note:** This tab is available only for Home Deluxe and Business licenses.

The parameters are divided into three groups:

**Strokes** Group. The parameters change the color of strokes in the resulting image.

**Color** (0-90). The higher the value, the more strokes are recolored and the more colors appear in the image.
**Saturation** (0-40). The parameter increases the brightness of random strokes. The default value is 0.

**Contrast** (0-100). The parameter makes random strokes darker/lighter.

**Correction** Group. The parameters change the color of the original image.

**Hue** (-180...180). The parameter shifts all colors by the same hue value.
Saturation (-100...100). The parameter lets toning the image with brighter colors. It allows you to change the intensity of colors: from neutral gray tones to bright colors.

Brightness (-100...100). The luminance of the image. At higher values the image is brighter while at lower values it is darker.

Distortion Group. The parameters change the shapes and proportions of the objects.

Strength (0-100). The amount the objects in the image are shifted and stretched. At a value of 0, there is no distortion.
Strength = 10

Strength = 90

Curvature (2-25). This parameter increases the waviness of contours.

Curvature = 5

Curvature = 22

Random Seed (1-9999). This is the starting number for the random number generator that defines the deformation of shapes and randomly combines strokes.
Random Distortions
ADJUST A CANVAS FOR AN OIL PAINTING

AKVIS OilPaint does not only convert a photo into an oil painting, it also lets you imitate painting on a canvas or any other uneven surface: corrugated paper, brick wall, ceramic coating, etc.

In the Decoration group switch to the Canvas tab and enable the Use Canvas check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom...

Adjust the canvas settings.
APPLY FRAMES TO AN OIL PAINTING

In AKVIS OilPaint you can also add a frame to your oil painting to create a real work of art.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and texture.

**Hint:** You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

You can apply these frames to your oil painting:

- **Classic Frame**
- **Pattern Frame**
- **Strokes**
- **Vignette**
- **Passe-Partout**
ADD TEXT OR WATERMARK TO AN OIL PAINTING

In AKVIS OilPaint, you can personalize your work of art by adding a signature, insert a logo or a watermark.

In the Decoration group switch to the Text tab and enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Read how to adjust the text/watermark settings.
WORKING WITH PRESETS

AKVIS OilPaint includes a number of ready to use presets (settings combinations) for the effect which help you start working. When moving a cursor over a preset in the drop-down list, the sample appears in the small window on the left side of the list.

A preset contains the settings of all tabs.
You can apply one of the AKVIS presets or modify the parameters to achieve the desired result.
To create your own preset, type a name for the preset into the field and press Save.
To return to the default settings of the selected preset, press Reset.
To delete your preset, choose it from the drop-down list and press Delete.
The AKVIS built-in presets cannot be removed.
You can save your presets to a .oilpaint file with . To load presets from the file use .
Read more how to import and export user presets.
The button opens the Preferences dialog box that looks like this:

- **Language.** Change the program language by selecting another from the drop-down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to Auto, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: Light, Gray, or Dark.
- **Preview Window Size.** Choose the desired value for the size of the quick preview window: from 200x200 px to 700x700 px.
- **Processing Size Limit.** Image processing is a very time-consuming operation. This parameter accelerates image processing by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined value, the image is processed in the usual way. If the loaded file is larger, the program will reduce the image, process it and enlarge it again to the initial size.
- **Animated Processing.** This option lets you observe the photo-to-painting conversion in real time. It makes the process more entertaining but takes more time to complete. You can uncheck the option to improve image processing speed. In this case you will see the result only after processing is finished.
- **Initial Image Scale.** This option defines the way the image is scaled in the Image Window.
  - **Fit to View:** the image is completely visible in the window;
  - **100%:** the image doesn’t scale (generally, only a part of the image is visible).
- **Hints Panel.** You can choose how the hints will be shown:
  - Under Image Window;
  - Under Settings Panel;
  - Hide.
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog** check-box. Enable this option if you want to use the System Open/Save Dialog. Otherwise, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel. If the check-box is selected the panel is always visible.
To save changes made in the Preferences window press OK.

If you need, click on the button Default to return to the default settings.
**BATCH PROCESSING**

**AKVIS OilPaint** supports the **Batch Processing** feature that lets you automatically convert a series of images with the same effect settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a booklet or when processing all frames of video.

If you use the standalone version of **AKVIS OilPaint**, read the instructions here.

If you use the **OilPaint** plugin in Photoshop, use this tutorial.
PRINT IMAGES IN AKVIS OILPAINT

In the standalone version of AKVIS OilPaint you can print the image. Press the button to open the Print options.

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.
In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.

- **Copies per Page.** It lets you specify the number of copies of the image on one page.
- **Horizontally** and **Vertically.** These parameters indicate the number of rows and columns for the copies of the image on the page.
- **Spacing.** The parameter sets the margins between the copies of the image.

In the **Poster** tab, it’s possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.
- **Pages.** If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).

- **Glue Margins.** If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.

- **Lines of Cut.** Activate the check-box to display the cut marks in the margins.

- **Show Numbers.** With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in the margins.

To print the image with the chosen parameters, press the **Print** button. To cancel and close the printing options click on **Cancel**.

Click the **Properties...** button to open a system dialog box that enables you to access the advanced settings and send the document to print.
The author of the example is Alberto De Donno.

Pictures taken in haste are often of poor quality and have no special meaning. Such images are usually deleted at the time of preview. However, you can combine several photos together and edit them to get an outstanding result. Just a few interesting details completely change the visual impression of an image.

Look at the following photo (picture 1). The gray background contains a lot of irrelevant details that distract the attention from a young couple.

Let's find a suitable romantic place for this loving couple!

I found a photo with a long alley which is lighted with the autumn sun (picture 2).
Colors and the entire composition of the image are good. But there are no meaningful objects and I thought that our young people might look more interesting at the beginning of the path.

Using the Photoshop **Clone Stamp** tool put the couple into the foreground of the second picture.

The result is shown in the picture 3.

The resulting collage is pretty nice: we have a warm background and the eye-popping characters. It remains to turn the collage into an oil painting to give it a romantic ambience and hide cloning defects.

I used **AKVIS OilPaint** that offers a rich variety of settings for converting any photo into an oil painting.
Use the **Stroke Direction** tool to make the strokes more realistic (the tool is only available for Home Deluxe and Business licenses). Choose a preset, for example **AKVIS Intense Oil** that generates intensely colored relief strokes.

The oil painting pierced with sunlight looks brighter compared with the original photo.

**AKVIS OilPaint** adds expressiveness to the image and amplifies the desired romantic atmosphere. The
painting looks like created by the hand of an artist. It makes you sense the warmth of the autumn sun, imagine the feelings of two people and feel the romance of their unhurried walk.

The quickest and easiest way to learn the features of the programs is to experiment with them. It can trigger your imagination as well.

Add the Canvas effect or a text; use different painting styles by selecting presets or adjusting parameter settings.

Make sure that the processing result correctly reflects your feelings and corresponds with your artistic intention.

We wish you much success and happy experimenting!
AKVIS OilPaint allows creating a work of art that looks like a real oil painting. For more reliability you can decorate it with a frame.

**Step 1.** Open the image in AKVIS OilPaint. We recommend using a staged photo or a collage.
**Step 2.** The preview window shows the quick result with the current settings (the *AKVIS Default* preset).

The result looks fine. You can increase the **Stroke Intensity** parameter to get more expressive brush strokes.
Step 3. Click on \( \) to start processing of the entire image.

**Note:** You can correct paint irregularities on the result and increase a handmade effect using the Smudge tool (only for Home Deluxe and Business licenses).

To make the painting even more realistic you can add a frame with **AKVIS ArtSuite**.
Oil Painting with Frame
AKVIS PROGRAMS

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture! More...
**AKVIS Chameleon — Photo Collage Creation**

(Windows | Mac)

**AKVIS Chameleon** is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. [More...](#)

---

**AKVIS Charcoal — Charcoal & Chalk Drawings**

(Windows | Mac)

**AKVIS Charcoal** is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. [More...](#)

---

**AKVIS Coloriage — Add Color to Black and White Photos**

(Windows | Mac)

**AKVIS Coloriage** allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object's border and tailors the new color to the grayscale tones of the initial picture. [More...](#)
AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

**AKVIS Decorator** lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

**AKVIS Draw** converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...
AKVIS Enhancer — Bring Detail To Your Pictures

(Windows | Mac)

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

AKVIS Frames is free software designed for working with the AKVIS frame packs

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your photos! More...
**AKVIS LightShop — Light and Star Effects**

(Windows | Mac)

**AKVIS LightShop** lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! [More...](#)

**AKVIS Magnifier — Change Image Size without Quality Loss**

(Windows | Mac)

**AKVIS Magnifier** helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. [More...](#)
AKVIS MakeUp — Retouch Your Portrait Photos!
(Windows | Mac)
AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

AKVIS NatureArt — Bring Nature to Your Photos
(Windows | Mac)
AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a number of effects: Rain
AKVIS Neon — Glowing Drawings from Photos
(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. More...

AKVIS Noise Buster — Digital Noise Reduction
(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be
seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...

AKVIS OilPaint  —  Oil Painting Effect
(Windows | Mac)

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel  —  Turn Photos into Pastel Paintings
(Windows | Mac)

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
**AKVIS Points — Apply Pointillism Effect to Your Photos**

(Windows | Mac)

**AKVIS Points** lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! [More...](#)

**AKVIS Refocus — Focus Improvement & Blur Effects**

(Windows | Mac)

**AKVIS Refocus** improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It's also possible to add bokeh and lens blur effects to your photos. The software works in five modes: **Refocus**, **Tilt-Shift**, **Iris Blur**, **Motion Blur**, and **Radial Blur**. [More...](#)
AKVIS Retoucher — Image Restoration Software

(Windows | Mac)

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. More...

AKVIS Sketch — Convert a Photo to a Pencil Sketch

(Windows | Mac)

AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings. Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch. More...
**AKVIS SmartMask — Save Time on Complex Selections!**

(Windows | Mac)

**AKVIS SmartMask** is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. [More...](#)

---

**AKVIS Watercolor — Aquarelle Art from Photos**

(Windows | Mac)

**AKVIS Watercolor** easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. [More...](#)